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Learn to animate with Macromedia flash

Module 1: Overview of Flash

This module will talk about what Flash is, what it does and the benefit of  adding 
Flash movies to your eLearning projects.

Module 2: Creating Your Movie

During this module, we will be creating a very simple movie. You will use the 
drawing tools, apply fills, modify stroke,  and tween your animation. You will  
understand how to create symbols, key frames and  how to manage your 
movie.

Module 3: ActionScript

Don’t freak out! Let’s make your movie better by having it play only once! This 
module will introduce you to the ActionScript necessary to make your move 
stop repeating itself!
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Module 1: Overview of Flash
Many people consider Flash to be the standard format for both simple and 
complex animation on the Web. They are embedded into the HTML of the web 
page and are displayed like a graphic or text file. The Flash plug in not only 
plays animation, but also recognizes user input and can control how the browser 
responds. For example, you could program your Flash animation to react to a 
user clicking on a button, and then open a new HTML page or download a file 
from within the animation.

The Adobe web site claims that 97% of web users can access Flash content. 
This is because the plug in required to play the Flash files is a standard with 
most current generation browsers. With the exception of Mozilla and Firefox, 
your browser already has the Flash plug in!

The greatest benefit of Flash movies and animations is that they download 
very quickly because of their small file size. Unlike animated GIFs, Flash files 
are largely vector-based. Vector based graphics are created with mathematical 
equations rather than the bitmapped color grid. This makes them easy to 
interpret and manipulate - the computer makes subtle adjustments to an 
equation rather than redrawing a complex series of images. 

Flash is not limited to just vector based output, however - you can import 
bitmap images and animate them as well.  These bitmapped pictures can be 
animated from within Flash, but extra steps may be required in order to make 
them appear as expected. 

Flash “movies” are generally easy to create, but caution should be demonstrated. 
Just becuase Flash “can” do a “thing”, doesn’t mean it should. Rely on Flash 
to enhance your eLearning by engaging the user in an interesting interaction, 
using it to create an easy to use interface, or to incorporate video and audio 
segments when appropriate.

In your eLearning projects, work to avoid the miscellaneous and distracting 
motion from your navigation and backgrounds. Remember that your learner is 
going to work through your program over the course of an hour or so, a flying 
star scape or fuzzy ball “mouse chaser” while cute for about a minute, gradually 
detracts from the overall presentation.
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Flash MX Top Feature List

Streaming Animations

The Flash Player streams animations as they download. This means that they 
can begin to play before the download is complete. Users will start to see the 
movie play within seconds! This includes audio and video files!

Vector Based Graphics

Vector graphics are lines, shapes and fills are displayed by the computer through 
mathematical functions, rather than bitmapped color grids. Because they are 
a set of equations, making them grow, shrink, turn and fade is easy on the 
processor. This makes Flash movie graphics appear sharp and quick. It gives 
Flash an advantage over Animated GIFs because the file sizes are small and 
there is no degradation of image quality as the dimensions of the graphics or 
movie change. 

Import and Export Graphics

Flash allows users to import graphics created in Illustrator, Photoshop and 
Fireworks, as well as generic EPS, GIF, BMP, and JPEG. Also, element drawn 
within Flash can be exported into these formats. If you use layers, layer effects 
or any specialized graphic techniques in Illustrator, Photoshop or Fireworks, 
those layers and effects import directly into Flash CS3!

Strong Multimedia Support

Flash CS3 supports the import of both video and audio segments, including 
tools to compress and optimize these elements for the best playback vs. file 
size decision making process. The video elements can be imported into Flash 
and then manipulated across the timeline, giving you the ability to give your 
users the ability to play, adjust and control the segment. Or, the video files can 
be converted to .flv (Flash Video) files and automatically stream in a player.

The best part is that a separate video or audio plug in is not necessary to view 
the Flash multimedia. The entire project gets converted to Flash and the user 
needs only the Flash plug in to view the project. No more plug-in messes!
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Interactivity and Language

Flash movies can be created using the native programming language called 
ActionScript. ActionScript 3.0 is the current version and is a derivative of 
JavaScript, and can add a high degree of interactivity to movies. Buttons, page 
turns, drag and drops and other sort of interactivity, including database and 
XML connectivity, can be programmed into Flash movies using ActionScript.

Learning Interactions

Learning interactions are a set of pre-programmed eLearning interaction 
types that can be easily dragged into or out of your project. No programming 
is necessary to implement a drag and drop, multiple choice question or hot 
spot/hot object interactions. The necessary code is already created for you. 
Change an graphic or two and you can rapidly develop learning interactions 
for your project!

XML

ActionScript 3.0 includes a group of classes based on the ECMAScript for XML. 
These classes include powerful and easy-to-use functionality for working with 
XML data. Using E4X, you will be able to develop code with XML data faster 
than was possible with previous programming techniques. As an added benefit, 
the code you produce will be easier to read.

Database Integration

Through ASP, .NET, PHP and other technologies partnered with ActionScript, 
Flash movies can import data from a database (like Access, SQL and mySQL). 
This data can influence the way the movie displays or change the content that 
displays when the movie is run. 
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Basic Interface

Below is a diagram of the Flash CS3 interface. Each section is numbered and 
referenced so that you understand a little about each area.

1

3

2

4

5

6

Number
1.

2.

Description
Main Menu:  You access many of the most common Flash 
commands from this line. File, Edit and View commands are here, 
as well as Flash specific Insert, Modify and Control menu options. 
We will use some of these during this session. 

Toolbar: This long bar is split displays icons for the various tools 
you will use in Flash. There is a section of drawing tools, viewing 
tools and color tools. We will be using some of the drawing tools 
during Module 2.
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Timeline: The timeline contains the frames of the movie and allows 
you to animate your content. Just like the frames of a movie, Flash 
frames display in order. Events occurring on the left side of the 
timeline will display before element further down to the right. Also, 
the timeline has vertical layers to allow for complex stacking. We 
will be adding layers and playing with the time line quite a bit.

Panel Sets: There are lots of panels for customizing your Flash 
movie. We will be working in a few of them during this session. For 
now, know that when I refer to a panel or panel set, it will be hanging 
off to the right of the screen. Each panel name is located on the 
tab above the panel selections. We will access different panels by 
using Window menu off the main toolbar.

Stage: This is where you will add graphics and content to your 
movie. This is also a representation of the area you have to work 
with for your movie. When developing your own projects, you can 
completely customize the size of your stage depending on your 
needs. 

The grey areas around the stage is called the work area. Objects 
that fly in from the outside of the stage can be positioned in this 
work area for inclusion in your movie.

Properties Inspector: The Properties Inspector will change its 
attributes based on the tool you are using, the items selected on 
the stage as well as which panel set you are using. The Properties 
Inspector may contain the same options available off the panel sets 
- think of this tool as a “most commonly used options” set.

3.

4.

5.

6.

During this session, I don’t expect you to know what every panel or tool can 
accomplish. My goal is to give you a test drive of the software and introduce 
you to some of its features.  I will hand hold you through most of it, so don’t 
worry.

Don’t be discouraged if you cannot find a tool or panel set right away. Watch my 
screen or ask your neighbor for assistance. This isn’t rocket science. No one is 
going to lose their life because you cannot immediately find the Line tool. What 
I am saying to you is to have fun with this program! Flash is very cool!
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Module 2: Creating Your Movie
You are going to be creating a movie that demonstrates some of the basic 
functions of animation in Flash. It is called “Mr. Ball Goes to San Antonio”, and 
it is destined to generate buzz at independent film festivals everywhere. 

Before you begin any animation project, you have to have a good idea of what 
you want to see happen; almost like a story board.

So, our movie looks like this.

1. Fade in: Mr. Ball Goes to San Antonio! Fade out.

2. Ball comes in and moves from one side of the screen to the other.

3. Ball changes location several times.

4. Ball meets antagonist, Mr. Square.

4. Fade in: The End

5. Stop movie.

6. Collect awards.

The first thing we are going to do is prepare the stage for our objects. We are 
going to add frame layers to house our individual elements. For our movie, we 
are going to need four layers. I know this because I designed this session, but 
during the development of your projects, you may not start out knowing how 
many you will need. It is easy to add and remove them, and while developing 
your project, you will be doing it all the time.

When we are done with 
this section, your layers 
will be stacked like this:

Actions
Title
Ball
Square
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Action 1: Adding Your Layers

When you first opened 
your Flash movie, you 
had just one layer called 
Layer 1. We are going 
to give your movie three 
more layers.

To Add A Layer:

1.	 On the layer panel, 
toward the bottom 
of the stack, click 
on the left icon.  
This is the add layer 
icon. 

2.	 A new layer titled Layer 2 will now display above Layer 1. 

3. 	 Click two more times until you have four layers.

Action 2: Changing the Titles of Your Layers

Layer 1 is not a good description of what is contained on your layer. After all, 
you may be creating movies that contain 25 or more layers. You need a way to 
understand what is contained on that layer. Flash allows you to assign a name 
to each layer in order to make them easier for you to know what is happening 
on each layer.

To Change the Title of Your Layer:

1. 	 Double click on the current layer title.

2.	 It will change to a text box and allow you to type in a new name. Press 
[Enter] when done.

3.	 Change the names of your layers to Actions, Title, Ball, Square, top to 
bottom. (Refer to the image at the top of this page).
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Action 3: Saving the File

Now would be a good time to save the Flash movie. Click on File -> Save. 
Choose a name and location for your file and click [Save]. Save it to the desktop 
using your first name as the filename.

This version of Flash is the most stable, but I’d hate for you to have to start 
over!

Action 4: Adding Your Title

We first will need a title for your masterpiece. We are going to type it onto the 
stage, and then animate it in the next section.

Locking Layers:
1. 	 Click on the lock icon 

at the top of the layer 
stack. This will lock 
down all the layers in 
our movie. Doing so 
makes sure that we are 
adding content to the 
right layer.

2. 	 Unlock the Title layer by 
clicking on the lock icon 
on that Layer. (Not the 
one at the top of the stack). This will unlock the Title layer, allowing us 
to add content.

Changing the Stacking Order of Your Layers

There may come a time when you want to change the stacking order of your 
layers. You can do so by clicking and dragging on the layer name. It will physically 
move the layer above or below the other layers you are displaying. We won’t 
need to do that during this session, unless you accidentally misname or move 
a layer.

Understanding Layers

The power of layers will very quickly become evident, but it is important to 
remember to place your objects on the correct layer. Things can get very 
confusing if your elements are placed on the wrong layer. If you were to draw 
the Ball on another layer, later when we are trying to animate the ball, it won’t 
go anywhere. You can ensure that you are on the correct layer by clicking 
on a frame on that layer, or by clicking on the layer title. 
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Adding Text:
1. 	 Click on the first frame on the Title layer.

2. 	 Click on the Text Tool in the toolbar. 

3. 	 You will notice that your cursor turns into an “I” beam. Click anywhere 
on the stage. 

4. 	 You now be able to type text onto the stage. Type “My Ball Goes to 
San Antonio [Enter] by [Your Name]”.

5.	 Click on the Black Arrow Tool in the toolbar.

6. 	 Single click on the text. You will now edit this text using the Properties 
Inspector. It is located on the bottom of the screen.

7.	 From within the character panel, change the font of your text, and 
increase the size to about 32 points.

8.	 Switch back to your Text Tool. Highlight the line “by you” and using 
the Character Panel, change the size to about 24 points. 
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Action 5: Your First Fade

You are very close to your first animation! But first, we need to add some frames 
to the movie. Our movie is going to be exactly 100 frames long. Again, I know 
this because I have created the movie for this session. You won’t know exactly 
how long your movie will be, so this process of adding frames will be useful to 
you when developing your project. 

Adding Frames to Your Movie

1.	 Using the scroll bar beneath the Timeline, scroll to the right until you see 
frame 140 displayed.

2.	 Click into frame 140 of the Actions (top) layer. 

3.	 Hold down the [Shift] key and click into frame 140 of the Square (bottom) 
layer.

4.	 You will now have a black bar filling frame 140 on all three layers. Press 
[F5]. 

5.	 By pressing [F5], you have added frames to your movie.

Information About Symbols

Before you can animate any object, you need to turn it into a symbol. Quite 
simply, a Flash symbol is an instance of an object in the movie. You can have 
many instances of a symbol in a movie. 

Imagine that you want to animate a flock of birds. It would be painful to have to 
draw and animate twenty-five birds on the screen. However, if you created just 
one bird and turned it into a symbol, you could reuse that same bird twenty-
five times. 

Just remember, before we can make it move, we have to turn it into a 
symbol.
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Creating the Text Symbol

1.	 Click on the black Arrow tool.

2.	 Click on the text. A blue box should surround the text, indicating that 
you have it selected.

3.	 Press [F8]. The Convert to Symbol dialog box displays. Name your symbol 
“Title” and click on the Graphic type.
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Information about Key Frames

Whenever you want to make a change to a symbol, you need to add a new 
keyframe. Key frames are where the action ends, or begins. For example, if 
you want to move a box from the left side of the screen to the right, you place 
a key frame at the starting position. Then, you move a bit down the timeline 
and place a second keyframe. 

In the second keyframe, you position the box where you want it to go after the 
move. Two keyframes, starting and ending positions and the graphic to animate 
are all you need. The next section will illuminate this point.

Adding Your Keyframe

1.	 On the Title layer, click on frame 12. 

2.	 Right mouse click on the frame and select Insert Key Frame.

3.	 You know have a key frame in frame 1 and also in frame 12.

We are going to fade the title in over these frames. So we need to add a motion 
tween between these two keyframes.

Adding the Motion Tween

1. 	 Right click on the Title layer, anywhere between frame 1 and frame 12.

2.	 Select Create Motion Tween.

3.	 The frame between frame 1 and 12 will turn blue/purple and now have 
an arrow through them. This is saying “Take whatever is in Frame 1 and 
move or transform it to whatever is in Frame 12.
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Adding the Fade

What we are going to do next is fade the text in from frame 1 to frame 12. When 
we added the keyframe to 12, it copied what was currently displayed in the 
previous keyframe: Fully visible text.

In frame 1, we are going to change the Alpha transparency to 0%, there by 
rendering it invisible.

1. 	 Click on frame 1 of the Title layer.

2.	 Click into the blue framed text box.

3.	 On the Properties Inspector (on the bottom of the screen), change the 
Color drop down menu to Alpha and the percentage from 100% to 
0%. 

3.	 The symbol is still there in frame 1, it is just so transparent that it is 
invisible.
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4.	 Now, we are going to add the fade out.  On the Title layer, add a keyframe 
to frames 24 and 36. (Right mouse click -> Add Keyframe)

5.	 In the frame 36, change the effect to alpha and percentage to 0%. (Click 
on frame 36, click in the blue box text, change the Properties Inspector 
Color drop down to Alpha and the % box to 0%.)

6.	 Right click between frame 24 and 36 and select Create Motion Tween. 
You are now fading out.

6.	 Move your playhead (the little red square at the top of the timeline. It 
has the red line coming down all of the frames) back and forward, from 
frame 1 to 36 and back. Your text is now fading in, displaying for about 
a second, and then fading out.

	 You did it! Your first fade! Your a Flash Animator!

7.	 Click on frame 37 of the Title layer. Right click on the frame and select 
Insert Blank Key Frame. This “erases” frame 37 and the other frames on 
this layer. 
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Action 6: Create the Ball

We are now going to create the star of your show: Mr. Ball!

1.	 Lock the Title layer by clicking on the dot under the Lock icon in 
the stack of layers. 

2.	 Unlock the Ball layer by clicking on the lock icon on the Ball 
layer.

 
3.	 Insert a keyframe into frame 40 of the Ball layer.

4.	 Click on the Oval tool. If you don’t see the Oval tool, click and hold 
down your mouse on the Rectangle tool until the menu displays. 
Choose the Oval Tool.

5.	 Your cursor will turn into a cross hair. While holding down the [Shift] 
key, click and drag a medium sized circle on the stage. Use the 
picture below to guide you.
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4.	 Adding a gradient will your ball a cool 3D look. Click on the black Arrow 
tool.

5.	 With the black Arrow tool, click on the center fill color of the ball on the 
stage. It should highlight.

6.	 Click on the Paint Bucket color chit on the Tool bar. Be sure to click the 
chit, not the tool.

7. 	 A color panel will pop up. 

8.	 Select one of the sphere-like color gradients located at the bottom of 
this pop up window. 

9.	 When you click on the color gradient, the fill on your sphere changes 
into this gradient. Your sphere now has a 3D look because of the radial 
gradient. 

10.	 Click on the black Arrow tool, if it is not already selected.

11.	 Click on the line surrounding the circle. It will highlight.

12.	 Press the [Delete] key to remove it. It now looks better without the black 
line around it.

14.	 Because we are going to animate this ball, we need to turn it into a symbol. 
Click on the ball to highlight it, then press [F8]. Name the symbol “Ball” 
and make it a graphic symbol.
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Action 7: Animate the Ball

During this action, we are going to make the ball bounce around the screen.
Because there are going to be so many things happening, we are going to need 
lots of keyframes and motion tweens!

Making the Ball Move!

1.	 Using the black Arrow tool, click on Mr. Ball and drag him off the stage 
to the left.

2.	 Right click on frame 55 of the Ball layer and choose Insert Keyframe.

3.	 Right click between frame 40 and 55 and choose Create Motion 
Tween.

4.	 Click on frame 55 of the Ball layer. Select the ball with the black Arrow 
tool and pull it to the right, bottom of the stage.

5.	 Scrub the playhead (the red handled bar) and watch the animation. Mr. 
Ball is Moving!

6. 	 Click on frame 55 of the Ball layer. Select the ball with the black Arrow 
tool and pull it to the right, top of the stage.

7.	 Scrub the playhead and watch the animation. Notice that Mr. Ball now 
moves to his new location!

8. 	 On the Ball layer, click on frame 70. Right click and choose Insert 
Keyframe.

9. 	 Right mouse click between frame 55 and 70 and choose Create Motion 
Tween.

10. 	 Click on frame 70. Click on Mr. Ball. Move Mr. Ball to the lower, center 
of the stage.
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11.	 On the Ball layer, click on frame 80. Right click and choose Insert 
Keyframe.

12.	 Right mouse click between frame 70 and 80 and choose Create Motion 
Tween.

13. 	 Click on frame 80. Click on Mr. Ball. Move Mr. Ball to the center of the 
stage. 

Introducing the Antogonist!

1.	 Lock the Ball layer by clicking on the dot under the Lock icon in the stack 
of layers. 

2.	 Unlock the Square layer by clicking on the lock icon on the Square 
layer.

3.	 Right mouse click on frame 80 of the Square layer and choose Insert 
Keyframe.

4.	 Click on the Oval tool and hold down the mouse until you see the menu 
display. Choose the Rectangle tool.

5.	 Your cursor will turn into a cross hair. While holding down the [Shift] key, 
click and drag a medium sized square off the stage on the left. Use the 
picture below to guide you.
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6. 	 Click on the black Arrow tool and then click once inside the square. 
Change the color using the Properties Inspector. Pick a color you like.

7.	 Click on the black Arrow tool, and then double click on the Square. This 
selects the colored center AND the line around the Square.

8.	 Press [F8] to turn it into a symbol, name it Square, and ensure that it is 
a graphic symbol. 

9.	 On the Square layer, right click on frame 120 and choose Insert 
Keyframe.

10.	 Right click between frame 80 and frame 120 and choose Insert Motion 
Tween.

11.	 Click on frame 80, and in the Properties Inspector change the Rotate 
drop down to CW and type 1 in the Times box.

12.	 Click on the black Arrow tool. Click on frame 120. Click on the Square 
and move it lower right, off the stage.
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Simulate Interaction

If you scrub the playhead, you will see that around frame 95, the square comes 
in contact with Mr. Ball. A collision occurs that sends Mr. Ball in a whole new 
direction! Let’s animate him and his reaction to the evil Square.

1.	 Lock the Square layer by clicking on the dot under the Lock icon in the 
stack of layers. 

2.	 Unlock the Ball layer by clicking on the lock icon on the Ball layer.

3.	 Scrub the playhead so you can determine which frame the Sqare hits 
the Ball. (Close to frame 95).

4.	 Right click on that frame (95) and choose Insert Keyframe.

5.	 Right click on frame 110 of the Ball layer and choose Insert Keyframe.

6.	 Click on the black Arrow tool. Click on Frame 110. Click on the Ball and 
drag it off the bottom of the stage.

Now, when the square comes in contact with the ball, it looks like the ball gets 
pushed off the bottom of the screen!

7.	 Save your movie File ->Save.

8.	 Test your movie by clicking Control->Test movie. Your movie will play 
over and over and over.

Congratulations! You’ve discovered the  
basics of making things move in Flash CS3! 
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 Module 3: ActionScript
When you tested your movie at the end of the last module, you noticed that it 
kept repeating itself. While this works well to during the development process, 
if you were really developing this animation for a project, you would want it to 
play once and then stop in the final version.

Adding this type of interactivity requires us to program Flash to stop. Flash has 
a native programming language called ActionScript. It is a language based on 
JavaScript that allows you to turn your Flash movie into a powerful, interactive 
experience.

While telling your movie to stop isn’t a powerful and interactive experience, it 
will give you a taste of ActionScript.

Action 1: Adding the Stop() Function

Just like every other element of the Flash movie, ActionScript needs to be added 
to a keyframe. The ActionScript you add will only occur when the timeline has 
reached its keyframe, so we are going to place the keyframe in the last frame 
of the Actions layer.

1.	 Lock the Ball layer by clicking on the dot under the Lock icon in the stack 
of layers. 

2.	 Unlock the Actions layer by clicking on the lock icon on the Actions 
layer.

3.	 Using the black Arrow tool, click on frame 140 of the Actions layer.

2.	 Right mouse click and select Add Blank Keyframe.

3.	 Open the Actions panel by choosing Window -> Actions

4.	 Using the black Arrow tool, click on the keyframe you added to frame 
140 of the Actions layer. 

5.	 In the main ActionScript window, type:

	 stop();

7.	 Test your movie by clicking Control->Test Movie. 

The movie will stop after the animation!
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On Your Own
On your own, here is an exercise for you to complete.

1.	 Add the words “The End” toward the end of your movie. Have the words 
fade  in and then stay on the screen when the movie stops.

2.	 Use the Title layer and start your animation in Frame 125.

Tips

1. 	 Add a single keyframe, then add your text to that keyframe.

2. 	 Before animating, remember to turn your text into a symbol.

3.	 Add your second keyframe, then right mouse click between them to 
Tween your keyframes.

4.	 The fading effect is located on the Effects panel.
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Summary
Flash is a great tool for eLearning, as long as it is not overused. As you 
experienced during this session, it is fairly easy to build animation into a site.  
Use Flash to add a bit of motion to your eLearning and enhance your learner’s 
experience. Remember to keep the motion graphics instructional in nature, and 
enhance the learner’s experience through animation. Don’t create an animation 
and place it into your eLearning just because you can, ensure that the placement 
meets or adds to a learning objective. 

Recommended Web Sites and Reading

Flashkit
A fantastic web site dedicated to all things Flash. If you want to start learning 
Flash, or just want to download and use some animations in your sites, this is 
the place on the web for Flash stuff. 
http://www.flashkit.com

Friends of Ed
Friends of Ed is a publishing group out of the UK that has a fantastic set of books 
on Flash, from version MX to the current version CS3. They are a “developer to 
developer” group of authors that really give you good, usable information on the 
product. I recommend starting with the Foundational Flash CS3 and then move 
through their ranks of books. They cover everything from Basic ActionScript to 
advanced database interactivity. 

You can find their stuff on-line or wherever you buy your computer books. 
http://www.friendsofed.com

Adobe Web Site
Macromedia has a very good web site that can give you more information 
about Flash. You can also download a fully functional version of Flash CS3 to 
try for 30 days. It is the perfect way to immerse yourself in the product before 
deciding to spend the money to purchase it.
http://www.adobe.com

Peach Pit Press
Peach Pit Press has a large number of Visual Quick Start Guides on all things 
computer, and the two Flash Quick Start Guides are really good (and cheap!)
http://www.peachpit.com


